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Introduction

Sedao content manager is an application that has been developed to enable you to easily synchronise
presentations across multiple digital signage players. It also provides a method to automatically retain backups of
presentations in a location of your choice.

Sedao Content Manager is a very powerful and flexible content duplication and backup system. This document
should allow you to set up and operate the application with ease but if you experience any problems or require
further assistance then please use the details in the further information section.

Installing Sedao content manager

If you have purchased a SWEP HD from Sedao, it will be pre-installed with the Content Manager application. You
can also download a 30 day trial from our website at www.sedao.co.uk. If the software is not yet installed on

your computer, please obtain a copy and follow the below instructions to install it. Content Manager only needs
to be installed on a management PC. You do NOT need to install anything on the PC’s to which content will be
distributed.

1. If you have a prior version of Content Manager installed, you will need to close it. To do so, right click the
Content Manager icon in the taskbar and select ‘Exit’. Wait for the icon to disappear before continuing.

2. Double click the setup program file. Read the ‘Welcome’ message. Click Next

3. Review the license agreement. Click ‘I accept...’ to acknowledge your agreement with the terms and
conditions. Then click Next

4. Accept the default installation folder, then click Next
5. Accept the default program icons folder, then click Next

6. Ensure ‘Create desktop icon’ is checked, and then click Next. If you would prefer Content Manager to start
each time your computer starts up, you can also click the ‘Start Content Manager with Windows’ checkbox.
Usually you will want to check this option to ensure Content Manager is always available.

7. On the ‘Ready to Install’ page, click Install

8. Wait for files to be copied, and then click Finish on the final screen. Leave the ‘Start Content Manager’ box
checked if you wish to open the application straight away.

9. The Content Manager icon should now be present in the taskbar.
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Starting Sedao Content Manager

You can show the Content Manager application window by double
clicking the Content Manager icon on your desktop. In the event the
icon has been removed from the desktop, simply click ‘Start’, ‘All
Programs’, ‘SedaO’, ‘Content Manager’, ‘Content Manager’.

If you chose the option during installation, Sedao Content Manager
will start automatically when your computer starts up. In this case, it
will be running in the system tray so that you can continue with other
tasks. You can double click the icon in the taskbar to display the main
window. See “Starting Content Manager with Windows” later in this
guide for further information on setting the startup option.

|i[§~:._; @ ) 1437

Explanation of the main product window

| Menu bar }\‘ & Sedao Content Manager 1.5.4 I —1ol x|
Fle Task Options Help

- s
|j New | g Edt | @] Refresh D Delete |0Run! Qstop |®Restora \ORun ALL Tasks

Name [status Promiess |Last Fiun |est Fun |
| Tool bar Ry Ide 2471172009 10:5754 24/11/2003 115754
PRI | 24/11/2009 10:57:55 24/11/2003 115755
Walching 24/11/2009 11:05:56 Disabled
Walching 24/11/2009 11:05:56 Disabled
H EREAOARIRIRONE. )/ IChi 24711/2009 11:05:56 Disabled
| Backup task list slcting e
R 7 - TR j
B add - [ Edit 3¢ Delete [ unic

| Destination folders }7—>

v

| File Name List

[earlier messages cleared because log length exceeded maximum of 20000) -

| Information Window Iiggggmmggggmﬁgw e

20051124 11:05:55 INFO e deinlih

Menu bar
The ‘File’, ‘Task’, ‘Options’ and ‘Help’ menus allow you to perform operations by selecting them with your mouse
or by using keyboard shortcuts.

Toolbar
Provides pictorial representations of the most common tasks the program can perform. These tasks are all
described later in this guide

V1.0 Page 3




Content Manager User Manual sedao

o
WWW.EE!C{B_D’.G-'

Backup task list
A list of backup tasks that you have created will appear here. You can also see the status, progress and ‘last run’

dates that apply to each task, as well as the next time that the task is scheduled to run. Click on a task to update
the ‘destination folder’ list pane. Most tasks can be double-clicked so that options can be edited.

Destination folder list
This is a list of destinations that the backup task will copy files or folders to. Expand the list to view details on the

most recent backups.

File Name list
If you select one of the destination folders, the files that were last copied for that particular task will be shown in

the ‘file name’ list. You can see the names, current backup status and the files date/time.

Information window
Information regarding the status of current or recent operations is displayed here.

Creating your first task

In order to start configuring the program to copy your presentation(s) to the intended location(s) you need to first
create a task which contains details of what to copy and what rules are applied when performing the copy.

1. Click ‘New’ on the taskbar.
B

General I Backup Actionsl Schedulel Importx’Expoltl

M arme:

— Source Folder

| Browse... |

¥ Include subfalders

[T Cornectto FTP Server ETE Settings... |

— Backup Type
% Keep a copy of files in the source falder

 Wersion controlled backups Advanced.. |
" Backup changed files

" Backup changed files and restore automatically

Ok I Cancel |

2. On the General tab, give your task a name such as “My Companies Presentation Backup Task”. This nhame
should help you identify what this task will do.

3. Click ‘Browse’ next to the source folder, and locate the folder containing the SIF file that represents the
presentation you wish to copy. Click ‘OK’ when you have found the correct folder.

4. Tick the ‘Include subfolders’ checkbox if you wish to also backup the presentations in subfolders of the
folder you located.
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5. Select a backup type that best fits your needs:

a) ‘Keep a copy of files in the source folder’. This is the default and most basic form of backup. This
option will copy the folder you have specified to destination folder(s) that you will specify later.

You may specify this type of backup to run daily at a specific time — Please see ‘Setting the schedule’
later in this guide.

This is the best selection if you wish to keep one copy of a presentation on a design PC and/or you
wish to synchronise the presentation once a day with several players on your network.

b) ‘Version controlled backups’. This selection will copy the folder you specified to the destination
folder(s) that you specify later. However, in this case, several copies of the presentation will be kept
so that you may audit changes or revert to prior versions as necessary. After clicking ‘Version
controlled backups’ you can click the ‘advanced’ button and select the number of versions that you

¥Yersion Control Settings El

bd awirmurm number of backups o keeps (10 :

wish to retain.

Select an appropriate number of backups that you would like to be kept, then click ‘OK’. Once the
specified number of versions has been reached, the oldest backup will be automatically deleted.

You may specify this type of backup to run daily at a specific time — Please see ‘Setting the schedule’
later in this guide.

This backup task is best if you wish to keep several copies of a presentation to audit changes or to
allow you to return to a prior day’s presentation if the changes you have made have not turned out
as required.

c) ‘Backup changed files’. This option will keep a constant watch on the folder you specified. If any
files are modified, those files will be instantly copied to the destination folder you specify later. If
new files are added to the presentation, these files will also be copied and if files are deleted from
the presentation, these files will be deleted from the backup folder.

NOTE: This type of backup task cannot be edited. You must delete it and create a new task.

This type of backup is best if you wish changes to the presentation to be updated as soon as they
have been made.

d) ‘Backup changed files and restore automatically’. This option will also keep a constant watch on the
folder you specified. If any files are modified those files will be instantly copied to the destination
folder you specify later. New files will be automatically copied and deletions will be deleted. In
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addition — if the SOURCE folder should be removed (the content is lost) — the folder and it’s content
will be automatically restored from the backup the next time that Content Manager is started. This is
useful if the presention is held on volatile memory that is erased after the power is interrupted. In
this case, the SOURCE folder will be automatically restored shortly after the PC starts up. This applies
to the entire folder. It will not have the desired effect if specific elements within the folder are
deleted.

NOTE: This type of backup task cannot be edited. You must delete it and create a new task.

6. You can specify what action will be taken if a file is unable to be backed up =
Genersl Backup Actions | Schedue | Import/Expart |

at the scheduled time. To do this, click on the “Backup Actions” tab. Then e S

& Rety later Advance d

select one of the following three options. © Siptie

sk user for action

a) Retry Later: |If a file cannot be copied (perhaps because it is
currently in use) then Content Manager will try to copy it again at
regular intervals. Click on ‘Advanced’ to customise the frequency
at which the copy process will be retried

Select the number of attempts that you would like Content
Manager to try and copy the file. You may also select the number |
of seconds between attempts. In the above example, Content ——
Manager will attempt to copy the file every minute for 1000 Timeoutbetween eties: [0 seconds
minutes. Click on OK when you are satisfied with the changes.
[ ok | concel |
b) Skip File: If a file cannot be copied (perhaps because it is
currently in use) then that file will be skipped and Content
Manager will try to copy the next file on it’s list.
c) Ask User For Action: If a file cannot be copied (perhaps because a
network connection has been lost) then a message will appear
asking the user to decide what to do to resolve the issue. NOTE: m £
processing will not continue until an option has been chosen. e CesabEWS e
o i e |
The ‘Retry’ and ‘Skip’ buttons have the same purpose as in a) and [
b) above. The cancel option will cause the entire copy process to LM

be ended with no further action being taken on remaining files.
IMPORTANT: Pressing ‘Cancel’ will result in an incomplete
backup/copy.
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7. For For “Keep a copy...” and “Version controlled...” backups, you may also specify a time of day at which

this type of backup will be executed. To do so, simply click the ‘Schedule’ tab.

x

a) To schedule a single backup at a specific time of day, click the sewal sauwacions sehedi | mpotmot]

u . ” W 35chedule fullaviomans backups Sve daak [ozas =

Schedule full automatic backups every day at” checkbox and S = ]

then choose a time that the backup will be performed each day.
b) To schedule regular backups throughout the day, check the

“Schedule periodic backups every” checkbox. Select from the

dropdown between ‘minutes and ‘hours’, then enter the

number of minutes or hours as required. ares

8. click ‘OK’ to save the changes and return to the task list screen. The next step in making sure the task is
successful is to define where you would like the files to be copied to.

Defining where you require each task to save it’s backup data
Once you have created backup task(s) that define what you want to be copied and how you would like it to be

selected — you now need to define where you would like copies of the files to be saved.

1. First select the task in the Content Manager window, for which you would like to define where file copies

will be saved. x

Aliaz [Optional]:
2. In the “Folder Destinations” section of the Content Manager !

Backup Folder

main window, click on ‘Add’ to select the first folder that you | frows._|

would like file copies to be saved F Commoctto FTP Semer FrP setings, |
3. Type a name in the ‘Alias’ box which should allow you to easily ¥ Eneled

recognise the folder where the backup will be stored. O

4. Click the ‘Browse’ button next to ‘Backup Folder’ and select the folder in which you wish to save the copy
of the presentation. Ensure the ‘Enabled’ checkbox remains ticked, otherwise the folder you have added
will not be included in the copy process. You should only un-tick the ‘Enabled’ checkbox if you do not wish
the presentation to be copied to the folder you selected — this is useful if you will not have access to that
folder for a short length of time.

5. Click OK to save the new destination details.

6. You can repeat the above steps to add additional folders to which the presentation files will be copied. For
example, if you had 5 players on your network you could create a single task that copied presentations
from one central location, to folders on each of the 5 players.

7. You have now completed all the steps necessary to perform copy processes on your folders
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Creating similar destination folder destinations quickly

If you are distributing a source folder to several SWEP computers on your network, you may find that it is tedious

to have to browse to the presentation destination folder on each computer in turn. Content Manager can help

you speed up this process by allowing you to duplicate a destination and then modify it. This is very useful if for

example your source is “c:\imageflyer\MyPresentation” and you need to set up destinations such as
\\swep1\imageflyer\MyPresentation

\\swep2\imageflyer\MyPresentation

\\swep3\imageflyer\MyPresentation

\\swep4\imageflyer\MyPresentation

\\swep5\imageflyer\MyPresentation

To use this feature

1. Click on the destination folder that you would like to copy.
Click the drop down arrow to the right of the ‘Add’ button in the destination folders panel, then click
‘Copy’.

3. The ‘Edit Backup Folder’ screen will be displayed, pre filled with the details ready for you to edit. Continue
to edit the destination folder settings as described in the “Defining where you require each task to save

backup data” section above.

Additional Features

Editing Tasks
You may at some point wish to change the settings you have defined for a task. For example, you may wish to

change the folder being copied or the number of copies that are retained.

a) “Keep A Copy” and “Version controlled” backup tasks can easily be edited. Simply double click the task in
your task list — or, click the task in the task list, then click ‘Edit’ on the toolbar.

b) “Backup changed files” and “Backup changed files with restore” cannot be edited. To change these you
must delete the task and create a new task.

Import and Export task settings

If you wish, you can save your backup configuration to a file so that you can B
import it at another installation or restore it in the event of a hardware
re p | aceme nt Impart... Impart task settings fom file

Expart... Export task settings to a file.

To Export a task:

1. Double click the task Id like t t.
ouble click the task you would like to expor —

2. Click the Import/Export tab.
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3. Click Export x

“® | This will apply any changes vou have currently made to the task,
2 Do ywou wank ko continue?

4. You may be prompted if you wish to save changes to the task.

Cancel |

Usually you would press ‘OK’. Pressing ‘Cancel’ will abort this

process.

5. Use the browse window to save your file in a safe location.

To Import a task:
1. Create a new task by clicking ‘New’ on the toolbar.
2. When the ‘Edit backup task’ window appears, click the Import/Export tab.
3. Click ‘Import’

4. Use the browse window to locate the file to import (you must have exported a file previously in order to
locate a file!).

5. You will be returned to the ‘General tab’. The settings are now restored. Click OK to save the task into
your task list.

Deleting a task

To delete a task, select it in your task list, then click the ‘Delete’ x|
button in the toolbar.
" E Are you sure you wank bo remove bask?
[

Cancel |

Click OK if you wish to delete the task. The settings for that task will
not be recoverable. Click Cancel if you have changed your mind.

Copy task
It is sometimes more efficient to copy an existing task and then change it — as opposed to typing in complex

source folder name(s) from scratch. If you wish to copy a task that you have defined, and then specify a new set
of destination folders for it, please follow this process:
1. Open Content Manager and select the task you wish to copy.

2. From the ‘Task’ menu, select ‘Copy Task’

3. The ‘Edit Backup Tasks’ dialogue will appear on screen with all the details copied from the task you
selected.

4. Simply edit the name of the task and then click OK to save the settings.

5. You will need to add some destination folders to save copies of your presentations.
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Copy task with folders
On occasions it will be more efficient to copy an existing task and its entire list of folder destinations — rather than

typing in complex source and destination folder name(s) from scratch. If you wish to copy a task that you have
defined and wish to use the same set of destination folders, please follow this process:

1. Open Content Manager and select the task you wish to copy.
2. From the ‘Task’ menu, select ‘Copy Task with Folders’

3. The ‘Edit Backup Tasks’ dialogue will appear on screen with all the details copied from the task you
selected.

4. Simply edit the name of the task and then click OK to save the settings.

5. Note that all the destination folders are already in the destination list.

‘Run’ / ‘Run ALL tasks’ / ‘Stop’ buttons
You may occasionally wish to run a specific task or all tasks immediately. This is very easy to do.

1. To run a specific task, click that task name in the list and then click the ‘Run!’ button.
2. Toinstantly run all tasks that you have defined, click the ‘Run ALL tasks’ button.

3. If a task is already running you can click the ‘Stop’ button to cancel the task in progress. NOTE: This will
result in an incomplete copy being created. You can also select ‘Stop All' from the ‘Task’ menu to stop all
tasks in progress.

Restoring a copy of data that has been backed up
Content Manager can be used to copy presentations to multiple locations. These may be to multiple digital

signage players, or to secure folders where you can hold backups of your presentation and its configuration.
There may come a time when you need to restore the presentation to the location that you backed it up from.

If you are recovering from a disaster scenario, you first need to make sure that your new hardware has the same
machine name and has the same shared folder structure.

1. Click the task that was used to backup the presentation you wish to restore.

2. Click the green arrow besides the destination folder that the backup was FEE=— ————————— =
stored in. i i

3. For all backup types except ‘version controlled’.

a) Double click the green arrow representing the destination folder until
you can see the blue arrow that reads ‘Latest version’.

b) Click this text once with the left button o o
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For the ‘Version controlled’ backup type

a) Double click the green arrow representing the destination folder until you can see multiple blue
arrows representing the dates and times of copies that have been generated.

b) Click the blue arrow representing the date and time of the backup that you wish to restore.

. Click the ‘Restore’ button on the toolbar.

Use the browse button or type in the path to which you wish the backup copy to be restored.
Click the ‘Restore’ button. While the files are being copied, the close button will be greyed.

When the close button becomes available, click ‘Close’ and the procedure is complete.

NOTE: If files already exist in the destination folder being restored to, those files will not be overwritten.

Edit destinations
At some point, you may wish to change the destination folders to which a backup task is being copied. For

example, you may purchase additional players, or you may wish to include a new USB drive in the task.

To edit the backup destinations:

1.

Open Content Manager and click on one of the tasks in the list.

In the ‘Folder Destinations’ pane, click one of the folder names next to the green arrows. The toolbar
above the pane will then become available.

Click the ‘Edit’ button. The ‘Edit backup task’ window will appear.

Make your desired changes and click OK.

Delete destinations
You may also wish to delete backup destinations to which backup tasks are copied. For example, you may have

changed a machine name, or moved a player to a network to which you don’t have access.

1.

V1.0

Open Content Manager and click on one of the tasks in your task list.

In the ‘Folder Destinations’ pane, click one of the folder names next to the green arrow(s). The toolbar
above the pane will then become available.

Click the ‘Delete’ button.

x

‘g) Are wou sure vou want ta remove selected backup Folder From the list?

Click ‘Yes’ if you wish to delete the destination. Deleting the destination will NOT delete the data that is
already stored at that destination. If you have changed your mind, simply click ‘No’.
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Using VNC to control your players from within Content Manager

If you have set up content manager to backup files to remote PC’s then providing the remote PC is running a VNC
server —you can connect to and take control of the PC holding the backup.

1. Open Content Manager

2. Select the backup task that copies data to the PC you wish to x|
control.

WHIC Host: I.-’-‘-.sus'l -Hp

3. In the ‘folder destinations’ list click on the green arrow m. U I—
- - ZET Name:
A

representing the PC you wish to take control of. Providing the PC is
Faszward: ||

i Cancel
4. Click the VNC button a Cancel |

not the PC you are using, the VNC button will become available.

5. Enter the password for the VNC server that you wish to connect to.

6. You will then be connected to the PC and able to control the keyboard and mouse. When finished, close
the Window to return to Content Manager.

Configuring the software’s advanced options

There are a few advanced options that power users may wish to change.

Automatically start tasks monitoring folders
On the options menu, you can select whether or not you wish to automatically start any tasks that monitor

folders for changes, when the computer starts up.

Each time you select this option, you will turn its status on or off. The status is ‘on” when there is a checkmark in
the menu.

NOTE: Checking the item does not start any folder monitoring tasks until you click exit and restart Content
Manager.
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Database location
Content manager uses a database file to store information about backup tasks and their current status. If

required, the database may be stored in a custom location. This may be desirable if you have created a complex
backup and distribution configuration and wish to be able to

x

- Databaze Storage

ensure the configuration is backed up by your existing backup

routines.

" Default Location

i Custorn Location

The database will require its own folder which you can

Browse. .. |

configure.
¥ Start Program 'when System Starts

1. Open Content Manager and from the Options menu ok | cancal |
select Preferences.

2. Click the ‘Custom location’ button.

3. Click the ‘Browse’ button and select an appropriate folder. Then click OK.

Alternately, select ‘Default Location’ to save the database within your current user profile.

Starting Content Manager with Windows
You can also specify whether you wish to have the software start automatically when Windows is started. If the

checkbox for “Start program when system starts” is selected, then Content Manager will start in the system tray
when the PC is booted. If this checkbox is not selected, you will have to start Content Manager manually to be
able to use it.

Import and Export Database
Content Manager uses a database to store information about backup tasks, folder destinations and each tasks

status. It is sensible to ensure that you have a backup copy of the database — especially if you have many complex
tasks configured.

To Export the database to a file: select ‘Export...” from the ‘File’ menu. Browse to the destination in which you
wish to save the file and give the file a name. Then click ‘Save’.

To Import a saved database file:

IMPORTANT: Importing a database file destroys any database currently in use — effectively removing all tasks and
folder destinations. Make sure you have exported your current database if you wish to preserve it.
IMPORTANT: Importing a database causes tasks within that database to run according to their schedule. For
example, ‘Backup changed files’ tasks will immediately be activated which could result in data being
unintentionally changed.

Select ‘Import..." from the ‘File’ menu. Browse to the copy of the file that you have saved. Double click the file to
start the import process.
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Reading status information and locating the logfile

Content Manager provides copious amounts of feedback regarding the status of your backup tasks.

Task Status
The status of each tasks can be found on the main screen.

Name: The name you gave the task when you created it.

Status: Idle means the task is not currently in progress. Watching means that a task is monitoring a source
folder.

Progress: The progress bars in this column indicate the progress of the task being completed.
Last Run: This confirms the date and time that the task was last run

Next Run: This confirms the date and time that the task will run next. This will be ‘disabled’ if the task status is
‘Watching’ as this type of task is real time and not operated by a schedule.

Destination Status
In the folder destinations list, you can check the status of the files that have been copied.

Select the task you would like to check, from the task list
Click the ‘+’ next to the destination folder alias that is listed in the ‘Folder Destinations’ pane.

3. For Version Controlled backups, click the ‘+’ beside the date and time you are interested in. For all other
task types, click the ‘+’ next to ‘Latest version’

4. Click the Blue item in the list to display the root folder of the tasks destination folder structure. You can
also click any of the subfolders in the folder destinations list. The status of files within your selected
folder is then displayed

Filename: This is the name of the file that has been copied.
Status: Completed means the file has been copied in it’s entireity to the destination folder.

Date: This is the date and time that the file was copied to the destination folder.

Status window
The status window at the bottom of the main Content Manager window shows the progress of the tasks that are

underway and provide feedback on the operations currently in progress. The status window holds the last 20,000
characters of information.

Log File
The Log File holds information on the recent activity that Content Manager has been performing. You can view

the log file by selecting ‘Open Log File’ from the ‘Help’ menu
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Using FTP for your source or destination folders

You can use an FTP (File Transfer Protocol) site to download presentation data from, or upload presentation data
to. The FTP setting will be available from your Internet Service Provider and/or corporate network administrator.

|
Server |

To download data from an FTP site

You may wish to download presentation data from a FTP site if you Pat; 2 =

are setting up a branch office that downloads data prepared by Usemame: |

their head office. In this way, the head office can synchronise Password: |

presentations across a suite of digital signage players.

Connection Mode: IActive 'I

Create a new task
Check the ‘Connect to FTP Server’ checkbox. Click ‘FTP = I Cance!
Settings’.

a. Fillin your server name, which will usually be in the format ‘ftp.myserver.co.uk’
b. The port will usually be 21’ but you can configure this as required.
c. Enter the username and password used to connect to your FTP account.
d. Select ‘Active’ or ‘Passive’ connection mode as appropriate.
e. Click OK
3. For the source folder, enter the FTP folder at which your presentation data is saved. For example,
‘/presdata/presentation1/’. If you wish to transfer the entire FTP site content, enter /' as the source
folder.
4. Complete the rest of the task settings as described earlier in this document.

x
Server |
To upload data to an FTP site
You may wish to upload presentation data to an FTP site if you are a Part [21 =
head office preparing presentation data for distribution to a suite of Userniame: |
branch office SWEP computers. Passward: |
1. Add a new ‘Folder Destination’ on a new or existing task Cornecion Made: [2cive |
2. Check the ‘Connect to FTP server’ checkbox
5. Click FTP Settings O | corce
a. Fillin your server name, which will usually be in the format ‘ftp.myserver.co.uk’
b. The port will usually be 21’ but you can configure this as required.
c. Enter the username and password used to connect to your FTP account.
d. Select ‘Active’ or ‘Passive’ connection mode as appropriate.

e. Click OK
6. For the backup folder, enter the FTP folder where you wish your presentation data to be saved. For
example, ‘/presdata/presentation1/’. If you wish to transfer data to the root of the site, enter ‘/’ as
the backup folder.
7. Complete the rest of the ‘folder destination’ settings as described earlier in this document.
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Licensing the Sedao Content Manager Application

If you purchased hardware and a Content Manager license from Sedao, then your license code will have been

entered for you at the factory. x|
If you purchased Content Manager seperately, the - Content

code may be on a CD or may have been e-mailed to 4| Mahager‘
you.

Application iz licensed.

Thank vou for pour inkerest in Sedao Content M anager.

If you downloaded Content Manager from our website
then it will be installed with a 30 day trial. To extend
the trial to a full version, you must purchase a license

Sedao website: v sedan.co.uk

code from your preferred reseller.

Product website:  wens. sedan. co.uk/products/sfm. htm

Enter R egistration Code:

Once you have the code, you need to enter it into the | | | | | Update |

software.

Pleaze enter Sedao Content b anager registration code to update pour licenze.

After the 30-day trial, the licensing screen is displayed

when you try to start the software. You can also enter
the code before the end of the trial by selecting ‘Register’ from the ‘Help’ menu.

Simply enter the product code you have obtained, then click ‘Update’. If prompted, exit the program and then
launch Content Manager again to restore full functionality.

Further Information
Sources for Further Information

Your Local Sedao Representative
Your Sedao representative will be able to assist you with any problems or queries you may have or put you in

direct contact with a technical specialist. Depending on your region, it may be possible to book on-site, off-site or
remote log-in training with Sedao through your representative. There is also a range of artwork, template and

screen creation services available on request.

The Sedao Website
Create an account here to gain access to the latest software updates and to obtain further information and

assistance: www.sedao.co.uk
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